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holidays on the net  1.1 Valentine’s Day Worksheet 1

Name: ………………………………………..

Date: ……………………….

Task 1 - Valentine’s Battleship

 Put or draw 6 hearts / sweets anywhere in the grid. Play the game in pairs for 5 
minutes. Use the right vocabulary!
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A B C D E F G

Do you have a heart in A1? / Is there a heart 
in A4? / Have you got anything in A7? / 
What about D2? 

No, it’s empty. / No, there is nothing. / 
Luckily not. 
Unfortunately, yes. / You sank it! / I lost it. / 
You did it.

Cross it out. How many hearts do you have left? /How many hearts have you collected?
It’s over. / Game over. / I have nothing left. / I have collected x hearts.
You / I won. You / I lost. 



holidays on the net  1.1 Valentine’s Day Worksheet 1 (cont.)

Task 2  – Learning about St Valentine

Task 2 a - Matching

 Put the right letter next to the corresponding number. You can get ideas from the 
text in Task 2 C.

1 rule A continue
2 volunteer B official rule
3 law C go away with no problem
4 priest D habit, regular activity
5 keep on …ing E job at the church
6 bride and groom F lead, govern
7 whisper G do something of one’s own free will
8 escape H say something in a very low voice
9 death penalty I capital punishment (the highest)
10 keep your spirits up J wife and husband at marriage ceremony
11 custom K someone else wins
12 be beaten L do not lose hope, be happy

Task 2 b – True or False? 

 Say if the following statements are true or false according to the text in Task 2 C.

True
√

False X Don’t 
know

?
1 Claudius II ruled the Roman Empire for less than two years 
(268 - 270).

?

2 Claudius did not let people get married.
3 Valentine was a young man who wanted to get married.
4 Valentine lived in a small room which he lit with candles.
5 He was put in prison because he helped people get married
6 When he was imprisoned, the young couple went with him.
7 Valentine had a lot of young visitors in jail.
8 The prison guard’s daughter fell in love with Valentine
9 Valentine’s Day is about love and friendship.
10 Sept 14 was the day when Valentine married the Guard’s 
daughter.



Task 2 c – Interviewing St Valentine

 Re-read the ‘self-portrait’ below with your partner and make questions to exploit 
the information. Underline the answers. Practice and act out the interview.
Q1 Who are you and when did you live?
Let me introduce myself. My name is Valentine. I lived in Rome during the third century. At that 
time, Rome was ruled by Claudius. I didn’t like Emperor Claudius, and I wasn’t the only one! A 
lot of people shared my feelings. 

Q2 ________________________________________________________________________

Q3 ________________________________________________________________________
Claudius wanted to have a big army. He expected men to volunteer to join. Many men did not 
want to fight in wars. They did not want to leave their wives and families. So what happened? 
Claudius had a crazy idea. He thought that if men were not married, they would not mind 
joining the army. So Claudius decided not to allow any more marriages. Young people thought 
his new law was cruel. I certainly did not want to support that law! 

Q4 ________________________________________________________________________

Q5 ________________________________________________________________________
Did I mention that I was a priest? One of my favourite activities was to marry couples. I kept 
on performing marriage ceremonies - secretly, of course. It was really quite exciting. Imagine a 
small candlelit room with only the bride and groom and myself. We used to whisper the words 
of the ceremony, listening all the while for the steps of soldiers. 

Q6 ________________________________________________________________________
One night, we heard footsteps. It was frightening! Thank goodness the couple escaped in time. I 
was caught. I was put in prison and received the death penalty. 

Q7 ________________________________________________________________________
I tried to stay cheerful. And do you know what? Wonderful things happened. Many young people 
came to the prison to visit me. They threw flowers and notes up to my window. They wanted me 
to know that they, too, believed in love. 

Q8 ________________________________________________________________________

Q9 ________________________________________________________________________
One of these young people was the prison guard’s daughter. Her father allowed her to visit me in 
the cell. We used to talk for hours. She helped me to keep my spirits up. She agreed that I did the 
right thing with the secret marriages. On the day when I was to die, I left my friend a little note 
thanking her for her friendship. I signed it, “Love from your Valentine.” 

Q10 _______________________________________________________________________
I believe that note started the custom of exchanging love messages on Valentine’s Day. It was 
written on the day I died, February 14, 269 A.D. Now, every year on this day, people remember. 
But most importantly, they think about love and friendship. And when they think of Emperor 
Claudius, they remember how he tried to stand in the way of love, and they laugh - because they 
know that love can’t be beaten!

Based on Isabel Perez’s work
http://www.isabelperez.com/St%20ValentineStory.htm

holidays on the net  1.1 Valentine’s Day Worksheet 1 (cont.)



holidays on the net  1.1 Valentine’s Day Worksheet 1 (cont.)

Task 3 – Evaluation

 Put the signs that you used in Task 2 B into the right columns. Then exchange the 
sheet with the classmate with whom you have worked.

Me My mate

I used the target language while playing the battleship game.
Or: I could identify lots of words in the word game.

I worked hard to learn about St Valentine.

I played an equal part while acting out the interview.

Our homework choice: ________________________________________________________

_____________________________________ ______________________________________

__________________________________ _________________________________________

_______________________________ ___________________________________________



Free Valentine’s Day cliparts: http://
www.hellasmultimedia.com/webimages/
valentine-htm/default.htm

How many words can you make out of 
Happy Valentine’s Day?
1 ......................................................................
2 .....................................................................
3 .....................................................................
4 .....................................................................
5 .....................................................................
6 .....................................................................
7 .....................................................................
8 .....................................................................
9 .....................................................................
10 ....................................................................
11 ....................................................................
12 ....................................................................
13 ....................................................................
14 ....................................................................
15 ....................................................................

Did you find? Put the right words before their explanation. 
1 Someone from another planet.
2 Very small.
3 A cat, a dog, or a goldfish. 
4 A big mammal.
5 Give something for temporary use. 
6 The opposite of like.
7 The opposite of early.
8 The opposite of sit.
9 Something to put food on. 
10 A fruit. 
11 A tragedy or a comedy.
12 Write on a keyboard. 
13 Small money. 
14 Jump forward, big step.
15 Make a picture.

holidays on the net  1.2 word game



holidays on the net  1.3 symbols



holidays on the net  2.1 Valentine’s Day Worksheet 2

Name: ………………………………………..

Date: ……………………….

Task 1 - Food and love

 a) Circle all the food words in the love-poem below!

I love you more than apple-sauce, (A) 
Than peaches and a plum, (B) 
Than chocolate hearts, (C) 
And cherry tarts, (C) 
And berry bubble-gum (B)

I love you more than lemonade,  
And seven-layer cake,  
Than lollipops,  
And candy drops,  
And thick vanilla shake.

I love you more than marzipan,  
Than marmalade on toast;  
For I love pies  
Of any size,  
But I love you the most.

By:  Jack Prelutsky
 b) Put all the food names into categories.

Main dishes or part of them

Sweets, candies

Cakes

Drinks

Fruit

Food for breakfast

 c) Write the corresponding taste under each picture!

sweet salty/savoury sour hot/spicy bitter

 d) Which category does most of the food in the poem belong to? .........................
Why? Because Love is ……………………….. but also can be .................................................



 e) Find the rhyme formula of each verse. Put the right letters in the end of each 
line! It will help you to pronounce the words better.

 f) Practise reading the poem in pairs; then act it out to the others.

Task 2 – Maths Translation

 Translate the quotation: “In the arithmetic of love, one plus 
one equals everything, and two minus one equals nothing.” 
(Mignon McLaughlin)

___________________________________________________________________________

___________________________________________________________________________

Task 3 - Planning Group Work

 a) Write the dates and the names of the holidays under the pictures that symbolise 
them. Name the symbols as well.

	 31 October 17 March
Thanksgiving

Clover (leaf)

17 March			   Halloween			   Clover (leaf) √		
31 October √			   St. Patrick’s Day		  Turkey			
24 November			   Thanksgiving √		P  umpkin

holidays on the net  2.1 Valentine’s Day Worksheet 2 (cont.)



b) Our holiday is: _____________________________________
Roles and timing (you can put some tasks together or divide them according to the number of 
group members)

Job and tasks Name:

Web Editor and Chief Editor: tries Netscape Composer (and 
teaches the others), helps the others, creates the Top 10 Links 
page, links the sub-pages to each other.

Game Editor: collects 5 URLs of very good online games, creates 
their page, keeps an eye on group work and time.

Resource Editor: collects 3 URLs of good resources on the history 
of the day, creates its page, takes care of correct references to 
original resources.

Picture Editor: collects URLs of 10 free images, creates their 
page.

Fun Editor: collects URLs of some related pieces of music, jokes 
or other extras, creates their page.

Other arrangements and agreements: 	
	
	

Task 4 – Self-evaluation

 a) Put a √ where applicable.
Very good Satisfactory Not too bad

My reading of the poem was

My knowledge about tastes is

The growth of my food vocabulary is

My work in planning group work was

Other:

 b) Compare your self-evaluation with a partner’s. Talk about it!

holidays on the net  2.1 Valentine’s Day Worksheet 2 (cont.)



holidays on the net  2.2 Name Tags

Chief Editor
Web Editor Game Editor

Resource Editor Picture Editor

Fun Editor   Editor
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Task 1 – Basic principles of building your own Holiday Webpage – 
Group discussion

 Have a look at the Holidays Webpage Skeleton and discuss in your group how to 
build your part. Look at the sub-pages of the Valentine’s Day one by one, read the 
expectations in the right column, and identify them in the Valentine’s pages. Your 
web page will be evaluated on the basis of these expectations!

How many HTML pages belong to a holiday? 5 

Colours, fonts, tables and alignment Colours and fonts can be different, but the 
basic structure must be the same. Use tables 
where the pattern does. Align them centred.

Navigation There are links to each sub-page and the 
main page on all pages.

History sub-page Create your own web page using the history 
resources, but simplify the information. 
Give the links of the original resources. Add 
a picture.

Images sub-page Put the images in a table, delete the HTML 
links (right click on the pictures), and give 
all the sources. Do not use images if you are 
uncertain about their free access (it should 
be declared on their homepages).

Games sub-page Choose some online games that help learning 
English and some that are just for fun. Make 
the difference obvious. Explain what you 
can find behind each link. Include a picture 
on the page.

Extras sub-page Make some holiday-related music available 
(by links only), explain what there is behind 
the links. You can also include some jokes 
or other fun, but do not forget to give the 
reference. Include a picture.

Top 10 Links sub-page Put the list of the 10 best links together 
when all the other pages are completed and 
you really know what the top 10 links are. 
Explain the content. Include a picture.

holidays on the net  3.1 St Patrick’s Day Worksheet



Some links to start with:
Caboose Free St Patrick Clipart for kids (close the ads, go down the page): http://www.
kidsdomain.com/holiday/patrick/clip.html
Quizzes and other staff
http://www.caslt.org/research/stpatrick.htm
Trivia Hunt
http://arthur.k12.il.us/arthurgs/stpthunt.htm
Video, interactive games etc.
http://www.ac-nancy-metz.fr/enseign/anglais/Henry/patrick.htm#voc
The History Channel on St Patrick, including video
http://www.historychannel.com/exhibits/stpatricksday/index.jsp?page=video

Task 2 

 Collect the resources you need
If you have more than needed, get together and choose the best ones to use.

Page Name and URL of the resource (copy paste), also the file names of the pictures 
that you have saved in your folder 

History

Images

Games

Extras

Top 10 Links

holidays on the net  3.1 St Patrick’s Day Worksheet (cont.)



holidays on the net  3.1 St Patrick’s Day Worksheet (cont.)

Task 3 

 Create the sub-pages one by one

Use this checklist!

No Done 

1 Find the folder named ‘St Patrick’ in the ‘Holiday’ folder. All the 
materials should be put there. The digital format of this worksheet is 
also available within the ‘St Patrick’ folder.

2 Open 5 new pages in Netscape Composer and save them as history_
SP.html, images_SP.html, games_SP.html, extras_SP.html, bestlinks_
SP.html

3 Fill in the ‘Page title and properties’ in the ‘Format’ menu (top of the 
screen). Save changes.

4 Choose ‘Page colour and properties’ in the same menu and set it.

5 Write the title in the middle; choose a font type and size (for all the 
pages of the holiday!). Save changes.

6 See the pattern (the corresponding page of Valentine’s Day) and create 
a table if necessary, use the ‘Insert’ menu. 
(choose the colours, write the text, take care of font size, colours and 
alignment – ‘Format’ menu). Save changes.

7 Create links where needed (‘Link’ menu). When using a saved file take 
care of using relative links. URLs must be copy-pasted. Save changes.

8 Insert the images you want to use. (They must be in the same folder)
Change the size if needed (“Format’ menu, ‘Image properties’) Save 
changes.

9 Open your page in Netscape Navigator (‘File’ menu, ‘Open’, ‘Choose 
file’) and check if it works

10 Correct whatever needs to be corrected. Save changes.

11 Compare your page to the Valentine pattern. Correct whatever needs 
to be corrected. Save changes.

12 Check the job with someone from the group.  Make the necessary 
changes and save them. 



Task 4 – Rehearsal

 Each group checks another website. All the members check the sub-page that 
they themselves have created about another holiday. 
(Fun Editors check the job of Fun Editors.)

 a) Look at the criteria in Task 1 and the Checklist in Task 3 and tick if the web 
page is

Very good		    Good		     Quite Good		     Needs basic improvements

b) List the concrete problems to be corrected 
(E.g.: Texts for links to other pages are missing)

1 __________________________________________________________________________

2 __________________________________________________________________________

3 __________________________________________________________________________

4 __________________________________________________________________________

5 __________________________________________________________________________

6 __________________________________________________________________________

7 __________________________________________________________________________

8 __________________________________________________________________________

9 __________________________________________________________________________

10 _________________________________________________________________________

 c) Go back to your own page with the evaluation and make the necessary 
corrections.

Task 5 – Putting the St Patrick pages together and linking them to 
the Holiday homepage

	Put all files of the holiday into a single folder (images, html pages, everything you have 
used or created), otherwise the website will not work. (Web Editor)

	Link the St Patrick sub-pages to each other. (Web Editor)
	Put all files of all 4 holidays into the Website Skeleton folder (images, html pages, 

everything you have used or created), otherwise the website will not work. (3 Web 
Editors)

	Link all the Holiday pages to the home of the Holidays Website. (3 Web Editors together)
	Check if it works all right. (3 Web Editors together)
	Upload the whole Holiday website to the School Website. (System Administrator + Chief 

Web Editor)

holidays on the net  3.1 St Patrick’s Day Worksheet (cont.)



Task 1 – Basic principles of building your own Holiday Webpage – 
Group discussion

 Have a look at the Holidays Webpage Skeleton and discuss in your group how 
to build your part. Look at the sub-pages of Valentine’s Day one by one, read the 
expectations in the right column, and identify them in the Valentine’s pages. Your 
web page will be evaluated on the basis of these expectations!

How many HTML pages belong to a 
holiday?

5 

Colours, fonts, tables and alignment Colours and fonts can be different, but the basic 
structure must be the same. Use tables where the 
pattern does. Align them centred.

Navigation There are links to each sub-page and the main page on 
all pages.

History sub-page Create your own web page using the history resources 
but simplify the information. Give the links of the 
original resources. Add a picture.

Images sub-page Put the images in a table, delete the HTML links (right 
click on the pictures), and give all the resources. Do 
not use images if you are uncertain about their free 
access (it should be declared on their homepages).

Games sub-page Choose some online games that help learning English 
and some that are just for fun. Make the difference 
obvious. Explain what you can find behind each link. 
Include a picture on the page.

Extras sub-page Make some holiday-related music available (by links 
only), explain what there is behind the links. You can 
also include some jokes or other fun, but do not forget 
to give the reference. Include a picture.

Top 10 Links sub-page Put the list of the 10 best links together when all the other 
pages are completed and you really know what the top 10 
links are. Explain the content. Include a picture.

Some links to start with:
Caboose Free Halloween Clipart for kids (close the ads, go down the page): http://www.
kidsdomain.com/holiday/halloween/clipart/1clip1.html
Quizzes and other staff
http://www.caslt.org/research/halloween.htm
Video, interactive games etc.
http://www.ac-nancy-metz.fr/enseign/anglais/Henry/hallo.htm
The History Channel on Halloween, including video
http://www.historychannel.com/exhibits/halloween/

holidays on the net  3.2 Halloween Worksheet



Task 2 

 Collect the resources you need
If you have more than needed, get together and choose the best ones to use.

Page Name and URL of the resource(copy paste), also the file names of the pictures 
that you have saved in your folder 

History

Images

Games

Extras

Top 10 Links

Task 3 

 Create the sub pages one by one
Use this checklist!

No Done 
1 Find the folder named ‘Halloween’ in the ‘Holiday’ folder. All the 

materials should be put there. The digital format of this worksheet is 
also available within the ‘Halloween’ folder.

2 Open 5 new pages in Netscape Composer and save them as history_
hallo.html, images_hallo.html, games_hallo.html, extras_hallo.html, 
bestlinks_hallo.html

3 Fill in the ‘Page title and properties’ in the ‘Format’ menu (top of the 
screen). Save changes.

4 Choose ‘Page colour and properties’ in the same menu and set it.
5 Write the title in the middle; choose a font type and size (for all the 

pages of the holiday!). Save changes.
6 See the pattern (the corresponding page of Valentine’s Day) and create 

a table if necessary, use the ‘Insert’ menu. 
(choose the colours, write the text, take care of font size, colours and 
alignment – ‘Format’ menu) Save changes.

7 Create links where needed (‘Link’ menu), when using a saved file take 
care of using relative links. URLs must be copy-pasted. Save changes.

8 Insert the images you want to use. (They must be in the same folder)
Change the size if needed (“Format’ menu, ‘Image properties’) Save 
changes.

9 Open your page in Netscape Navigator (‘File’ menu, ‘Open’, ‘Choose 
file’) and check if it works

10 Correct whatever needs to be corrected. Save changes.
11 Compare your page to the Valentine pattern. Correct whatever needs 

to be corrected. Save changes.
12 Check the job with someone from the group.  Make the necessary 

changes and save them. 

holidays on the net  3.2 Halloween Worksheet (cont.)



Task 4 – Rehearsal

 Each group checks another website. All the members check the sub-page that 
they themselves have created about another holiday. (Fun Editors check the job 
of Fun Editors.)

 a) Look at the criteria in Task 1 and the Checklist in Task 3 and tick if the web 
page is

Very good		  Good		  Quite Good		  Needs basic improvements

 b) List the concrete problems to be corrected (E.g.: Texts for links to other pages 
are missing)

1 __________________________________________________________________________

2 __________________________________________________________________________

3 __________________________________________________________________________

4 __________________________________________________________________________

5 __________________________________________________________________________

6 __________________________________________________________________________

7 __________________________________________________________________________

8 __________________________________________________________________________

9 __________________________________________________________________________

10 _________________________________________________________________________

 c) Go back to your own page with the evaluation and make the necessary 
corrections.

Task 5 Putting the Halloween pages together and linking them to 

the Holiday homepage

 	Put all files of the holiday into a single folder (images, html pages, 
everything you have used or created), otherwise the website will not work. 
(Web Editor)

 	Link the Halloween sub pages to each other. (Web Editor)
 	Put all files of all 4 holidays into the Website Skeleton folder (images, html 

pages, everything you have used or created), otherwise the website will not 
work. (3 Web Editors)

holidays on the net  3.2 Halloween Worksheet (cont.)



 	Link all the Holiday pages to the home of the Holidays Website.  
(3 Web Editors together)

 	Check if it works all right. (3 Web Editors together)
 	Upload the whole Holiday website to the School Website. 

(System Administrator + Chief Web Editor)

holidays on the net  3.2 Halloween Worksheet (cont.)



Task 1 – Basic principles of building your own Holiday Webpage – 
Group discussion

 Have a look at the Holidays Webpage Skeleton and discuss in your group how 
to build your part. Look at the sub-pages of Valentine’s Day one by one, read the 
expectations in the right column, and identify them in the Valentine’s pages. Your 
web page will be evaluated on the basis of these expectations!

How many HTML pages belong to 
a holiday?

5 

Colours, fonts, tables and alignment Colours and fonts, can be different but the basic 
structure must be the same. Use tables where the 
pattern does. Align them centred.

Navigation There are links to each sub-page and the main page on 
all pages.

History sub-page Create your own web page using the history resources 
but simplify the information. Give the links of the 
original resources. Add a picture.

Images sub-page Put the images in a table, delete the HTML links (right 
click on the pictures), and give all the resources. Do 
not use images if you are uncertain about their free 
access (it should be declared on their homepages).

Games sub-page Choose some online games that help learning English 
and some that are just for fun. Make the difference 
obvious. Explain what you can find behind each link. 
Include a picture on the page.

Extras sub-page Make some holiday-related music available (by links 
only), explain what there is behind the links. You can 
also include some jokes or other fun, but do not forget 
to give the reference. Include a picture.

Top 10 Links sub-page Put the list of the 10 best links together when all the 
other pages are completed and you really know what the 
top 10 links are. Explain the content. Include a picture.

Some links to start with:
Caboose Free Thanksgiving Clipart for kids ((close the ads, go down the page) http://www.
kidsdomain.com/holiday/thanksgiving/clipart/1clip1.html
Quizzes and other staff
http://www.caslt.org/research/Thanksgiving.htm
Video, interactive games etc.
http://www.ac-nancy-metz.fr/enseign/anglais/Henry/thanks.htm
The History Channel on Thanksgiving, including video
http://www.historychannel.com/thanksgiving/

holidays on the net  3.3 Thanksgiving Worksheet



Task 2 

 Collect the resources you need
If you have more than needed, get together and choose the best ones to use.

Page Name and URL of the resource(copy paste), also the file names of the pictures 
that you have saved in your folder 

History

Images

Games

Extras

Top 10 Links

Task 3 

 Create the sub pages one by one
Use this checklist!

No Done 
1 Find the folder named ‘Thanksgiving’ in the ‘Holiday’ folder. All the 

materials should be put there. The digital format of this worksheet is 
also available within the ‘Thanksgiving’ folder.

2 Open 5 new pages in Netscape Composer and save them as history_
thanks.html, images_thanks.html, games_thanks.html, extras_thanks.
html, bestlinks_thanks.html

3 Fill in the ‘Page title and properties’ in the ‘Format’ menu (top of the 
screen). Save changes.

4 Choose ‘Page colour and properties’ in the same menu and set it.
5 Write the title in the middle; choose a font type and size (for all the 

pages of the holiday!). Save changes.
6 See the pattern (the corresponding page of Valentine’s Day) and create 

a table if necessary, use the ‘Insert’ menu. 
(choose the colours, write the text, take care of font size, colours and 
alignment – ‘Format’ menu) Save changes.

7 Create links where needed (‘Link’ menu), when using a saved file take 
care of using relative links. URLs must be copy-pasted. Save changes.

8 Insert the images you want to use. (They must be in the same folder)
Change the size if needed (“Format’ menu, ‘Image properties’) Save 
changes.

9 Open your page in Netscape Navigator (‘File’ menu, ‘Open’, ‘Choose 
file’) and check if it works

10 Correct whatever needs to be corrected. Save changes.
11 Compare your page to the Valentine pattern. Correct whatever needs 

to be corrected. Save changes.
12 Check the job with someone from the group.  Make the necessary 

changes and save them. 
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Task 4 – Rehearsal

 Each group checks another website. All the members check the sub-page that 
they themselves have created about another holiday. (Fun Editors check the job 
of Fun Editors.)

 a) Look at the criteria in Task 1 and the Checklist in Task 3 and tick if the web 
page is

Very good		  Good		  Quite Good		  Needs basic improvements

 b) List the concrete problems to be corrected (E.g.: Texts for links to other pages 
are missing)

1 __________________________________________________________________________

2 __________________________________________________________________________

3 __________________________________________________________________________

4 __________________________________________________________________________

5 __________________________________________________________________________

6 __________________________________________________________________________

7 __________________________________________________________________________

8 __________________________________________________________________________

9 __________________________________________________________________________

10 _________________________________________________________________________

 c) Go back to your own page with the evaluation and make the necessary 
corrections.

Task 5 – Putting the Thanksgiving pages together and linking THEM 
to the Holiday homepage

 Put all files of the holiday into a single folder (images, html pages, everything 
you have used or created), otherwise the website will not work. (Web 
Editor)

 Link the Thanksgiving sub pages to each other. (Web Editor)
 Put all files of all 4 holidays into the Website Skeleton folder (images, html 

pages, everything you have used or created), otherwise the website will not 
work. (3 Web Editors)
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 Link all the Holiday pages to the home of the Holidays Website. 
(3 Web Editors together)

 Check if it works all right. (3 Web Editors together)
 Upload the whole Holiday website to the School Website. 

(System Administrator + Chief Web Editor)
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Task 1 – Identification

 Tick the holiday you will explore! Name all of them. Do you remember the 
dates?

Date: Date: Date:

Task 2 – The History of the day

 Read the history of the holiday in the website and list 5 important or interesting 
facts.

1 _________________________________________________________________________

2 _________________________________________________________________________

3 _________________________________________________________________________

4 _________________________________________________________________________

5 _________________________________________________________________________

Task 3 – Playtime

 Try some of the games related to the holiday, given in the website. Choose the 
best one.

Name/title of the game: ________________________________________________________

URL: ______________________________________________________________________

What can you do there? Explain it in 3-4 sentences. _________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________
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Task 3 – Images

 Chose the best one, copy-paste it here:

Task 4 – Try some Extras and Top Links

 Choose a link or an extra activity and introduce it to someone who has not seen it:

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

_________________________________________________________________________

Task 5 – Print your worksheet 

 Check the format of your worksheet. It must not be more than 2 pages. Print 
your worksheet if possible. If not, e-mail it to your teacher.

Task 6 – What have you done? - Discussion

 Get together with your holiday focus group and have a chat about your 
explorations. Use your notes and ask each others questions, like ‘What have you 
done?’ ‘What have you seen?’ ”What did you find out about the holiday?’, etc.
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5.2 – Evaluation Sheet

 Reflect on the aims of the module and your work done. When ready ask the 
others in your group about their opinion of the module and your work done.

The aims of the module were Did you like it? Were you good at it?

Your opinion Peer opinion

        

To learn about the origin of 
Valentine’s Day.

To make an interview with St 
Valentine and act it out.

To learn about food and 
tastes.

To deal with poetry and to 
read poetry.

To learn how to share tasks in 
group work.

To find, evaluate and select 
information on the web.

To build a sub-page using 
a pattern + Netscape 
Composer.

To connect the individual 
pages to each other.

To evaluate and correct the 
jobs done.

To learn about two more 
holidays (the holiday your 
group done + 1).

To develop evaluation skills.

To give polite opinion and 
criticism of other people’s job.

Other:
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